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INTRODUCTION 
First of all, thank-you for your interest in helping out with the scorekeeping 

of our games. Division 3 Softball is able to provide a quality softball 

experience through the work of many volunteers like yourself. 

This document is intended as a training guide for new scorekeepers, as well 

as a reference guide for more experienced scorekeepers who are looking to 

refresh their knowledge of situations that don’t come up all that often. It 

covers many topics in general softball scoring of plays, as well as how to 

enter those plays into the K-ForCE scoring software that we use. 

Scorekeeping Sign-Up 

Sign-ups for scorekeeping are done via the Scorekeeper Game Sign-Up link 

on the Division 3 Softball web site (see http://www.division3softball.org). 

Instructions for using the sign-up app are provided to scorekeepers who 

complete their training along with their login credentials. 

Arrival for Scheduled Scorekeeping 

Scorekeepers should arrive at the field at least 30 minutes prior to the game 

that they signed up to score. This is when the sub players are drawn and 

lineups are completed. There may be some work prior to the game to adjust 

lineups in the scoring program (see Update Lineup) and sometimes it is 

desired to start games a bit before the scheduled time, when possible. 

Players who are playing in a previous game should report to the score tower 

as soon as possible after their game is completed. 

Cancellations 

If you need to cancel a previously scheduled scorekeeping assignment, 

please notify the scorekeeper coordinators by e-mail as soon as possible so 

that a replacement can be found. For cancellations prior to the day of the 

scheduled game, please remove your assignment from the Scorekeeper 

Game Sign-Up app on the web site so that another scorekeeper can sign up 

for that game. 

Unusual Events 

Should something unusual occur during your game and you are unsure if 

you got it corrected, please contact one of the scorekeeper coordinators at 

the field before you leave. Scoring results are picked up by “The Daily 

Sun” from the Dropbox where you save them, often before we leave the 

fields for the day. Also, some corrections can only be made on the computer 

where the game was scored. When problems are not discovered until we 

https://www.division3softball.org/cgi-bin/ScorekeeperSignUp.cgi
http://www.division3softball.org/
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arrive at home after a game day, it is sometimes necessary to make a 

separate trip back to the fields to make corrections. 

Special Instructions – Windy Days 

Our All-In-One computers (non-laptops) can be somewhat unstable on the 

benches in the scoring tower. On windy days, a particularly strong gust has 

been known to blow one off the bench. This has happened even during a 

game. Worse, it has been known to happen that the scorekeeper in the 

reflex of trying to prevent the computer from falling to the floor has hit the 

power button and turned the computer off. 

We strongly recommend that if there is wind blowing into the scoring tower, 

the window in front of the computer be closed, if not totally, then at least 

enough to restrict the force of the breeze. 

Special Instructions – Hot Days 

The All-In-One computers have all of their electronics behind the screen and 

rely on air circulation to cool them. They have no internal fan. For this 

reason, the primary use for the fans in the scoring towers needs to be to 

circulate air past these computers on particularly hot and sunny days. If 

these computers are allowed to overheat, the first get very slow and 

eventually will stop operating. 

The laptop computers, on the other hand, have their electronics below the 

keyboard where the sun does not reach them easily and generally have 

built-in fans. Because of this, consider placing them in the sunniest windows 

on hot days (see Computer Use Rotation). 
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OPENING THE GAME 

Open the Game File 

Open the Score Sheet for your game by double clicking on the file in the Div-

3-Games folder. Files are in the form “XXXXX v YYYYY mm-dd-yyyy.KSS” 

where the XXXXX and YYYYY are the first 5 letters of visiting and home team 

names and the mm-dd-yyyy is the date of the game. 

When you open the program, the screen should look like the image below. 

 

 

 

Update Lineup 

The initial score sheet in the “Today’s Games” folder will contain a lineups 

submitted by the team managers the evening prior to each games. These 

lineup will not contain subs, since those are chosen a half hour prior to the 

games. There can also be last-minute changes. You will need to review the 

lineup cards given to the score booth against the lineups in the program to 

determine if changes are needed. The lineups are shown in the highlighted 

areas (see below). The visiting team is shown when the program is opened. 

You can view the home team by pulling down the “View” menu and selecting 

“Home Team” (see below). 
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The Opposing Pitcher is shown at the bottom of the lineup. If either team 

has not designated a pitcher, ask the team manager to identify one. The 

pitcher is the only defensive position that must be identified. 

It is essential that the lineup in the program matches the lineup card. Errors 

in the lineup that are not caught prior to the game may not be correctable 

later.  

 

Lineup Area and Opposing Pitcher 
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View Menu 

 

There are four columns in the Lineup Area.  

The “#” column is the players ID number. This is not his uniform number, 

but a number assigned to track the player’s statistics with this team through 

the season. Roster players have numbers less than 20. Subs have numbers 

50 and above. Clicking on a cell in this column will display a pull-down list 

that shows roster players and subs who have played on this team previously 

(see below). 

 

The “Player” column is for the player name. This column should almost never 

be entered manually (see Adding a Sub) 
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The “P” column is for the player’s position. Clicking on this cell will display a 

pull-down list of positions (see below). The only position that is important to 

track correctly is the pitcher. 

 

The “I” column is for the inning that the player enters the game. It should be 

1 for all players at the start of the game. It will only be anything else for 

injury subs or pitching changes (see In-Game Lineup Changes). 

Lineup Manager Updates 

If the lineup entries in the file do not match the computer printed entries 

on the lineup sheet, it may be that the lineup was changed after the game 

file was downloaded.  

You may close the scoring program and download a new file from the Lineup 

Manager (see Lineup Changes) to update the file. Then re-open the new file. 

This is only for cases where the printed lineup does not match the lineup in 

the score file. All hand-written changes should be addressed using the 

methods below.  

Adding a Sub 

The first step in adding a sub to a lineup should always be to check if that 

sub has already played on the team. Click on the “#” cell in the first empty 

lineup spot and scroll through the list to see if the player is already there. If 

so, just select the player from that list. This will fill in the “#” and “Player” 

columns. In some cases, the hand-written name at the bottom of the lineup 

may also be a roster player who was previously not included in the lineup, 

but was a late addition. Roster players will always be in this list. 

If this is a new sub for this team, note an unused player number above 50 

from the “#” menu. Type that number into the “#” column and hit tab. Next, 
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call up the “Player List” program. It should already be running on the 

computer. You may need to minimize the scoring program to see it. In the 

“Player List” program, type a few letters of the sub’s name into the “Search” 

box (see below). This will shorten the list. Click on the sub’s name in the list 

and click on the “Copy” button. Then, in the scoring program, click on the 

“Player” cell in the row for the sub (see below). Then right-click and select 

“Paste”. 

Care should also be taken to ensure that the correct name is selected in the 
“Player List” tool. There can be several players with the same or similar last 

name. 
 

 

Player List Program – Search 

 

 

“Player” Box Selected 

In some cases, a sub will register to play the same day he subs for the first 

time. When this happens, his name will not appear in the player list. The 

scorekeeper should verify with the sub desk that he has filled out a 

registration form. This is important – players should not play in a 

game and leave the field without filling out a form. It is also possible 

that the sub was previously registered, but that the name is mis-spelled on 

the lineup card. Always use the spelling in the “Player List” tool for existing 
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players. Once his registration has been verified, follow the procedure above 

to find a new sub number for the player. Type that in the “#” column and hit 

the tab key. Then, type the player’s name in the form “Firstname, S-

Lastname” into the “Player”column. 

Once the player’s number and name have been entered, select his position 

in the “P” column from the pull-down list. Then hit the tab key and enter “1” 

in the “I” column. 

By using this procedure, it should almost never be required to type a sub’s 

name in the “Player” column. Only in the cases of a new sub should that be 

done. 

Another way to determine if a sub already has a number on a team is to 
switch the “Roster:” selection from “All Subs” to a specific team. That will 

display the current roster as a list like that below. This may also allow you to 
more easily determine unused sub numbers in cases where there are many 

subs. 
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Delete a Roster Player 

In some cases, a player may be a late scratch from a lineup. If he was at the 

end of the lineup, that entry can be cleared and/or replaced by the sub (if 

needed). In most cases, the player is higher up in the lineup and all the 

players below him need to be moved up one spot. 

The simplest way to do this is to right click on the lineup entry and select 

“Clear” (see below). Then, right click on the entry below the empty spot and 

select “Cut”. Then, right click on the first empty spot and select “Paste”. 

Note that is it important to never left click on any entry in the lineup while 

doing this or you will not select the entire entry to cut or paste (see below). 

If you accidentally left click on an entry, click somewhere on the score sheet 

to clear the selection and then right click the intended entry. 

 

Lineup Entry Clear/Cut/Paste – Correct 
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Lineup Clear/Cut/Paste – Incorrect 

 

Another way to accomplish the change is to select each player’s number in 

the “#” column and select the number of the player in the entry below. The 

name will automatically change (and should never be typed or selected 

manually). The player’s positions will also need to be manually changed to 

correspond by clicking on the cell in the “P” column. The last entry will then 

need to be cleared or changed to as sub as appropriate. 

Insert a Roster Player 

In some cases, a player shows up to play a game that the manager did not 

expect. Rather than adding him at the end of the lineup, the manager often 

wants to put him in farther up. Inserting a roster player into the lineup uses 

similar methods to deleting one. 

Starting with the last player in the lineup, cut the player and paste him one 

entry down in the lineup (see Delete a Roster Player) for cut and paste 

instructions). When the spot is clear where the roster player is to be 

inserted, click on the cell in the “#” column to activate the pull-down list of 

players. Select the player to be inserted. This will fill in the “#” and “Player” 

columns. Next, select the cell in the “P” column to activate the pull-down list 

of positions. If no position is indicated on the lineup card, select EH – Extra 

Hitter. Then, hit tab and enter a “1” in the “I” column to indicate that the 

player will start in the first inning. 
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As for deleting a player, the change may also be done by clicking on the “#” 

column of each row that needs to change and selecting the correct player. 

The “P” column will also need to be clicked to change position assignments, 

as needed. Also, make sure that there is a “1” in each row of the “I” column. 

Complex Lineup Changes 

Sometimes, when a player is a late scratch or shows up unexpectedly, the 

manager wants to make several changes to the batting order to make best 

use of the players who are available. This can be done with a number of cut 

and paste operations (see Delete a Roster Player) for cut and paste 

instructions), where lineup spots below the 11th one can be used to 

temporarily hold lineup entries that you need to get out of the way. If you 

do this, be sure to remove those entries when you are done re-arranging the 

lineup. 

In this case, however, it might be easier to use the pull-down menus in the 

“#” and “P” columns to make the changes. 

Checking the Lineups 

Once changes have been made to a lineup, a visual check should be made to 

ensure that the batting order in the program matches the lineup card. After 

that, pull down the “File” menu at the top of the page and select “Save”. 

Then, push the “Check” button on the “Player List” tool and select the game 

you are scoring (see file selection box image below). Click on “Open” once 

the correct file has been selected. The tool will perform a number of checks 

on the lineup and display any errors it finds. Please make corrections, as 

needed, prior to scoring the game. This will save time when the game is 

incorporated into the web site and will provide more correct information to 

the newspapers who pull their information from Dropbox. 

It does not hurt to run the checks even if you haven’t made any lineup 

changes. Sometimes the lineup submitted by a manager can have a problem 

that can be found and fixed prior to the game beginning. 



Computer Scorekeeper Procedures Page 12 

 
 
Some of the checks performed are – 

 Same player is in the lineup twice 
 More than one pitcher listed 

 Starting inning is not 1 
 Players listed beyond the 12th entry 

 A blank entry is found before the last entry 
 A player number is incorrect for a player 

 A player number is incorrect for a sub who played a previous game for 
this team 

 A player named as a roster player (no S- in last name) is not on the 
roster 

 A player named as a sub (S- in front of last name) is a roster player 
 A player is not listed in the Player List 

 A player named as a sub has a number less than 50 
 There are fewer than 10 players in the lineup 

 No pitcher is listed in the lineup 

 
If errors are detected, they need to be corrected prior to the game starting. 

If there are problems with player numbers for roster players or subs who 
previously played on the team, the “Player List” tool can display the correct 

numbers for each player. Errors of this type occur when the “Player” column 
in the lineup is changed to a different player for a previously assigned 

number. In the “Player List” tool, select a team, rather than “All Subs” in the 
“Roster” menu (see below).  



Computer Scorekeeper Procedures Page 13 

 
 

The tool will list the players and subs who have numbers on the team. In the 

“#” column for the incorrect player, select the correct player number. The 

wrong name will appear in the “Player” column. Select the correct player for 

that number in the “Player List” tool and click on “Copy”. Then, left-click on 

the “Player” cell to select the cell to change and right-click to paste the 

correct name in. Then hit the tab key. 

Note that if you see a small black triangle on the lower right of any lineup 

entry (see below), this indicates that there is a stray entry in that entry. 

Clicking on the triangle will scroll down the list. Do this until the entry 

appears. When you do, a small black triangle will appear in the upper right 

of the entry. Clear the stray entry and then click on the upper small triangle 

to scroll back to the top of the list. 
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Game Information - Optional 

Game information is initialized by the Lineup Manager. If you have time prior 

to the start of the game, you may review this information and make any 

corrections due to last minute game or personnel changes. To check the 

game information, pull down the “View” menu and select “Game 

Information” (see below). 

 

This will bring up a dialog box that displays and allows changes to several 

game details to be changed (see below). Do NOT change Visitors, Home, 

Date or Time. You may change the Location, Score Keeper or umpires, if 

they are incorrect. 
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SCORING THE GAME 
The scoring program screen is divided into a few main regions (see below). 

The largest region – upper left – is the scoresheet. With a few exceptions, 

this is only used to display the scoring results. In a few cases, it is used to 

select a player and at bat to make a scoring update. 

Below the scoresheet on the left is the opposing pitcher lineup. Each time a 

pitching change is made, a name will be added to this list. 

To the right of the pitcher lineup are Runs (R), Hits (H), Errors (E) and Left 

on Base (B) by inning. This will be automatically updated. 

In the upper right corner is the “At Bat Scoring” area. This is where most of 

the scoring entries will be made. The number in the circle is the number of 

the next out that will be made. Bases with runners on them will be 

highlighted. 

Below that is the upcoming batting order, including in-game batting 

statistics. This is automatically updated. 

In the bottom right corner is the scoreboard. This is automatically updated. 

 

Note that the score box for the first batter in the first inning is highlighted 

(the background color is a bit darker). This indicates where (batter and 

inning) entries in the “At Bat Scoring” area will be entered. As scoring 
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entries are made, this automatically advances from batter to batter. There 

are times when entries may need to be made out of sequence. Clicking on a 

different score box will change the entry to that box (e.g. to record some 

outs made by a runner on base). Be careful to note that the highlighted box 

is on the batter and inning is where you intend to make an entry. The 

batter’s name is also at the top of the “At Bat Scoring” area. 

Spray Chart Lines 

On each play where the ball is put in play (batted fairly), the scorekeeper 

should record the approximate location and type of hit. To do this, right-click 

on the location in the field that will be the end point of the line and select 

the type of hit (see below). Note that if you right-click on one of the player 

position numbers in the field, the names of the fielders will be displayed. The 

spray chart menu will still appear and you can clear the names from the 

display by left clicking somewhere else on the field afterward. 

      

Hits 

If a batter puts a ball in play and reaches first base and all forced runners 

reach the next base, the batter should always be credited with a hit. If a 

forced base runner, is thrown out advancing one base, but the batter 

reaches first base, the batter should be given a Fielder’s Choice (see Runner 

Out – Fielder’s Choice). For an unforced base runner, it is a judgement call 

as to whether the fielder could have played on the batter or a forced runner, 

but chose not to. If the fielder could have made a play on a forced runner, 
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score a Fielder’s Choice. If not, give the batter a hit and mark the runner out 

stretching (see Runner Out – Taking Extra Base). 

There are two methods for entering hits into the scoring program. You can 

either use the “Hit” menu or just click on the appropriate base to signify the 

type of hit. 

Pull-Down Hit Menu 

To enter a hit using the hit menu, click on the “Hit” button to get a menu 

and then select the hit type (see below). Click on “Batter” to complete the 

entry (see below). 

 

Click on Base 

To enter a hit by clicking on a base, hover the mouse over the base until it 

enlarges and then click on it (see below). Be sure to avoid clicking on the 

adjacent position number, as that will enter an out rather than a hit. Click on 

“Batter” to complete the entry (see below). 
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Runners Taking Extra Bases 

The scoring program will move base runners along that are forced. Runners 

that take an extra base will need to be moved manually by clicking on the 

“More” menu and then clicking on the correct “Advance Runner to …” 

selection (see below). Note that the “Batter” button must be clicked after 

entering the hit in order to get the “More” menu to appear. If multiple 

runners need to be advanced, it is important to advance the runner closest 

to home first. Otherwise, there is a risk of putting two runners on the same 

base. Once two runners are on the same base, it is difficult to get them 

apart again and often further runner advances result in the trailing runner 

passing the lead runner. 
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More Menu                              Runner Advanced to Third 

RBIs 

Runs scored are RBI’s when they score as a result of the batter getting a 

base hit, but if the run scores as a result of an error (see Errors) it is not an 

RBI. An RBI can be given on a play with an error as long as the error did not 

make the difference between the run scoring or not. For example – 

 Runner on third with less than 2 out. If there’s an error on the play at 

first base, give the RBI. The run would score even if the batter was 

out. 

 An RBI would not be given in the same situation with 2 outs since the 

out at first would end the inning and the run would not have scored. 

 No RBI for an error on a play to the plate where the run scores. 
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 Give an RBI on the Sacrifice Fly with an Error (see Sacrifice Fly with 

Error). 

RBI’s are given even if the batter makes an out or on a fielder’s choice play 

as long as no error was made that caused the run to score. RBIs are not 

awarded for hitting into a double-play. 

RBIs are automatically added to a scoring play when the result of the play 

forces a run in. RBIs can be added for runs scoring without being forced by 

left clicking on the RBI indicator in the “At Bat Scoring” area (see below). 

RBIs can be removed by right clicking on the RBI indicator in the “At Bat 

Scoring” area. 

 

Outs 

Outs can be recorded a number of different ways. The “Outs” display on the 

“At Bat Scoring” area will display the number of the next out (see below). 

The out number will also be displayed in the scoresheet entry for each player 

who is out, whether as a batter or runner (see below). 
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Batter Out 

An out for the batter should be recorded if he puts the ball in play and fails 

to get to first base safely. See below for special cases of a Sacrifice Fly, 

Double Play or Triple Play. For the other cases, there are two ways to record 

an out for the batter.  

The most general way to record an out is to click on the “Out Circle” in the 

“At Bat Scoring” area. This will open an entry box to allow more detail to be 

supplied (see below). The detail is optional, but helpful sometime to answer 

questions about the scoring of a game. Some good examples of what to put 

there are – 

 A single position number – ball caught by that player. Use 8 for both 

center fielders. 

 X-Y – where X and Y are position numbers. This is a play where the 

ball is fielded by position X and thrown for a put out to position Y. 

 “Out of box” – batter stepped out of the batters box. 

 “Hit by Batted Ball” – batter was hit by the batted ball in fair territory. 

Position numbers are shown on the field in the “At Bat Scoring” area. Click 

on “Batter” to complete the scoring entry. 

For a fly ball, line drive or popup caught by a fielder, you can click on that 

position number. This will also open an entry box for more detail, but will 
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initialize it with the player number (see below). Click on “Batter” to complete 

the scoring entry. 

     

Click on Out Circle                      Click on Fielder 

Runner Out – Fielder’s Choice 

A Fielder’s Choice (FC) should be scored when a runner other than the batter 

is put out on the bases before advancing one base on a batted ball. If the 

runner is not forced, there is some judgement involved. If the runner goes 

immediately on the hit, score an FC. If the runner delays and a play is 

attempted somewhere else first, but the runner is still thrown out advancing, 

then just record the out for the runner and give the batter what he would 

otherwise have been entitled to (see Runner Out – Taking Extra Base). 

To record the play, pull down the “FC” menu in the “At Bat Scoring” area and 

select the runner who was out (see below). Note that the menu items refer 

to the base that the runner started from, not where he was going. As with 

other outs, an entry box will open to allow scoring detail to be entered. This 

will be included in the scoring box for the player who was out. Click on 

“Batter” in the “At Bat Scoring” area to record the entry (see below). 

There has been a lot of discussion (people unhappy) about the way we score 

an FC on a ball hit to the outfield and played to a base for a force out. This 
has been researched and we are scoring it correctly for softball. In baseball, 

an FC is not scored unless an infielder makes the play, but for softball this 
restriction is not in place. 
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Runner Out – Taking Extra Base 

If the batter reaches first base and all forced runners advance one base, but 

a runner is out taking an extra base, this is not a Fielder’s Choice (see 

Runner Out – Fielder’s Choice). This is also the case for an unforced runner 

when a play is made somewhere else prior to getting the runner out. In 

these cases, the batter should be given a hit (see Hits) and the runner out 

on the bases. 

There are two ways to record the out. Both are done after the hit is scored 

for the batter and runners are advanced to the last base that they reached 

safely. 

One way to record the out is to drag the runner from one of the bases in the 

“At Bat Scoring” area to the out circle. This will pop up a menu with out 

detail that mostly does not apply to softball (see below). Select 

“Other/Unspecified” and an entry box will open to allow you to provide detail 

similar to other outs (see below). Enter the detail and click on “Batter” to 

record the out. 



Computer Scorekeeper Procedures Page 24 

      

The other way to record a runner out on the bases is to first select that 

runner’s scoring box in the scoresheet. The box will then be highlighted and 

the “At Bat Scoring” area will show that batter’s progress on the bases (see 

below). Clicking on the out circle will then open a box where you can provide 

detail of the play (see below). Enter the detail and click on the “Batter” 

button to record the information. 

       

Batter Out – Taking Extra Base 

If the batter reaches first base and all forced runners advance one base, but 

the batter is out taking an extra base, the batter should be given a hit first 
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(see Hits) and then marked out as a base runner taking extra bases would 

be (see Runner Out – Taking Extra Base). If the batter reaches second base 

or third base safely before being thrown out, he should be given a double or 

triple respectively. 

Strikeout 

If a batter swings through a pitch, or does not swing at a pitch called a strike 

by the umpire or bats a ball found with two strikes, the batter is scored with 

a strikeout (K). Click on the “K” in the “At Bat Scoring” area and this will 

bring up the strikeout menu (see below). Select “K – Strikeout” for all cases. 

Then click on “Batter” to record the entry (see below). 

      

Sacrifice Fly 

A sacrifice fly is scored when, with fewer than two outs, the batter scores a 

runner with a fly ball or line drive that is caught. When a batter hits a Sac 

Fly he is not charged a time at bat, therefore it is important that all Sac Flies 

are recorded properly. 
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To score a sacrifice fly, pull down the SAC menu and select “SF – Sacrifice 

Fly”. Note that the RBI and Out will automatically be recorded and the base 

runner will be advanced from third base to home. Click on “Batter” to 

complete the entry. 

      

Double Play - Standard 

The Double-Play menu contains a number of standard double plays for the 

most common situations with outs at first and second base (see below). As 

long as the outs are made at first and second base, choose one of the plays 

that most closely resembles the play that took place. In cases where the 

short fielder is involved (normally position 0), it is fine to substitute the 

shortstop or second baseman (positions 6 or 4). For example, in the play 

where the shortstop fields the ball and throws to the short fielder covering 

second base who then relays the ball to first base for the out, it is fine to 

select the 6-4-3 double play. For any double play that results in outs at 

another base, please use the Wizard (see Double Play - Wizard) so that outs 

will be recorded for the correct base runners. 
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To get the double-play menu, click on “DP” in the “At Bat Scoring” area (see 

below). Click on the play that most resembles the play on the field and then 

click “Batter” (see below). 

      

Double Play - Wizard 

The Double-Play Wizard allows the scorekeeper to construct the play 

indicating both the players who made the play and the base runners who 

were out. Note that the wizard should not be used with less than one out if 

the two outs are made at third and home as it does not advance the runner 

from first to second and both the batter and runner will end up on the same 

base. Advancing a runner from that base will cause the batter to pass the 

original runner. That play requires a different approach (see Double Play - 

Constructed). 

The use of the wizard take a bit of getting used to. In cases where the two 

outs are the first two in the inning, it is recommended that the scorekeeper 
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ask the announcer to hold the game while the play is entered (see Pause the 

Game). This will prevent missing the next play if the batter should put the 

ball in play on one of the first pitches. 

To open the wizard, click on “DP” in the “At Bat Scoring” area to get the 

Double-Play menu and select “DP – Double Play” (see above). The first 

selection to be made is to indicate the first player put out (see below). Click 

on the base where the runner was at the start of the play. Next, click on the 

position number of the defensive position who fielded the ball, followed by 

clicking on the defensive player’s position number who made the putout. If 

one player fielded the ball and tagged a runner or the base, only enter one 

position number. Then click on “Next Out” (see below). Next, indicated on 

the runner who was put out second (see below). Again, click on the base 

where the runner started at the beginning of the play. Next, click on the 

position number of the player who made the second putout (see below) and 

click on “OK” to complete the construction of the play. You will then be 

reminded that base runners may still need to be advanced to match where 

they ended up at the end of the play (see below). Click on “OK” to 

acknowledge this. Click “Batter” to complete the entry of the Double Play 

(see below). At that point, advance any runners as needed to match the 

scoring to the final result of the play (see Runners Taking Extra Bases). 
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Double Play - Constructed 

Any Double Play may also be constructed by first marking the out for the 

base runner who is out closest to home (see Runner Out – Taking Extra 

Base) then, either marking the batter out (see Batter Out) or the second 

runner out (see Runner Out – Fielder’s Choice) in order to get the correct 

two players out. For the batter’s out or FC, add the DP notation to the out 

detail. Don’t forget to check the final locations of all runners and advance 

them as needed (see Runners Taking Extra Bases). 

In the case of a fly ball caught and a runner not tagging up in time, it might 

actually make more sense to enter the result for the batter first and then the 

runner. 

Triple Play - Wizard 

To score a Triple Play, click on the “More” button to get the “More Menu” 

(see below) and select “TP – Triple Play”. This will bring up the Triple Play 

Wizard. This works similarly to the Double Play Wizard (see Double Play - 

Wizard), except that three outs need to be recorded instead of two. As 

always, hit “Batter” to record the scoring result (see below). 



Computer Scorekeeper Procedures Page 30 

      

Walks 

If a batter walks, put down the “BB” menu on the “At Bat Scoring” area. This 

will open the walk menu (see below). Select “BB – Base on Balls (Walk)” 

whether or not the walk was intentional. Do not use the IBB selection. It 

does not record the information correctly. Click on the “Batter” button in the 

“At Bat Scoring” area to record the entry (see below). 
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Errors 

An error should be scored when a defensive player should have made a play 

to get the batter out, but failed to do so. There is a great deal of judgement 

involved in whether or not a defensive player should have made the play. 

When making this call, please keep in mind that the standard to use is 

whether or not it was a routine play for an average Division 3 Softball 

player. Please do not judge our players against MLB players or even the best 

of Division 3. Some things to consider in this are how hard the ball was hit 

(e.g. how fast was it travelling), and how far the fielder needs to go to be in 

position to make the play. Keep in mind that just because a ball hits a 

defensive player’s glove, it is not necessarily an error. An outfielder who is 

running full speed when the ball barely touches his glove probably did not 

commit an error. 

To score the error, click on the “E” in the “At Bat Scoring” area (see below). 

The error detail will be filled in with “E” and pause for you to add a position 

number for additional detail, which is optional. Click on “Batter” to complete 

the entry. If the batter or baserunners take extra bases due to the error, 

advance them as you would for runners taking extra bases on a hit. 
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Dropped Fly Ball 

If a stationary fielder drops a fly ball in the outfield that would not have been 

a sacrifice fly (see Sacrifice Fly and Sacrifice Fly with Error), then the batter 

is on base by an error. A fly ball or popup that is dropped by a stationary 

infielder should be an error.  

Missed Ground Ball in Infield 

If an infielder fails to field a ground ball or slowly bouncing ball and would 

have had time to make a throw to first base in time to get the batter, an 

error should be scored. Again, take into account how hard the ball was hit 

and whether or not the fielder had time to get into position to make a play. 

Bad Throws to First Base 

If a bad throw is made to first base or the fielder covering the base drops 

the throw, and the batter did not beat the throw to the base, an error 

should be scored. 

A batter who beats a throw to first base should be awarded a hit, whether or 

not the fielder there makes the catch. 

Missed Ground Ball in Outfield 

A ground ball or bouncing ball that is misplayed by an outfielder should be 

scored a hit, but the number of bases (single, double, triple or home run) 

depends on what the batter would have gotten if the ball had been fielded 
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correctly. Award the hit first (see Hits) and then advance the runners and 

batter to indicate where they ended up. 

Take into account field conditions (sun, wet grass, uneven ground – bad 

bounce) when determining whether or not an average fielder should have 

made the play. 

Sacrifice Fly with Error 

An error on a fly ball to the outfield that would have been a Sacrifice Fly (see 

Sacrifice Fly) should be scored SFE – Sacrifice Fly with Error. Click on “SAC” 

to get the Sacrifice menu, then select “SFE – Sac Fly, reached on Error” (see 

below). The error detail will be filled in with “E” and pause for you to add a 

position number for additional detail, which is optional. Click on “Batter” to 

complete the entry. Advance baserunners as needed to match where they 

actually ended up. 

    

Bad Throws to Second / Third / Home with Runner Advancing 

An error made on a play to a runner who is not the batter should be scored 

as an FC – Fielder’s Choice (see Runner Out – Fielder’s Choice) where all 

runners advance safely. To score this, first advance runners to where they 

ended up. Then put in the spray chart line (see Spray Chart Lines). Finally, 
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click on the FC in the “At Bat Scoring” area and select the “No Runners 

Advance” option (see below). Then, Click on “Batter” to record the result and 

move to the next batter (see below).  

Note: This, rather complex sequence is needed because the “All runners 

advance safely” options does not always seem to work and it is possible to 

end up with two runners on a base (which is very difficult to fix). 

      

Special Cases 

There are some unusual calls that scorekeepers sometimes have to deal 

with. These don’t come up very often, but require some special attention 

when they do. 

Batting Out of Order 

When a batter comes to the plate and it is not his turn to bat, do not call 

attention to it. The announcer should announce the correct batter, on deck 

and in the hole one time. Only if the umpire asks should any additional 

information be provided to the field. It is up to the opposing manager to 

challenge this. 
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If the mistake is discovered before the batter puts the ball in play, he will be 

replaced by the correct batter who will assume the count (balls and strikes) 

of the incorrect batter. There is no other penalty for this. 

If the mistake is discovered after the incorrect batter puts the ball in play, 

but before another pitch is thrown, an out is charged to the batter who 

should have batted and the batting order resumes with the batter after him. 

For example, if the 3rd and 4th batters are skipped and the 5th batter bats. 

The 3rd batter is out and the 4th batter comes to the plate. If anyone else 

comes to the plate next, he would also be batting out of order. 

If the mistake is not discovered before a subsequent pitch is thrown, there is 

no call and the batting order continues now from the batter who follows the 

incorrect one. In the example above, the 6th batter should bat. 

To enter batting results for batters who bat out of order, simply click on the 

box in the scoresheet that corresponds to the batter and inning that is 

appropriate and enter the scoring as normal. When you click on a scoresheet 

box, it will be highlighted. When you hit the “Batter” button after scoring 

that batter, the next score box will be highlighted and scoring will continue. 

If the mistake is discovered after you have scored the batter who was out of 

order, clear that entry (see Corrections) and score the out for the batter who 

should have been up (see Batter Out).  

Runner Hit by Batted Ball 

If the batter is hit by the batted ball in fair territory, he is out (see Batter 

Out). It is a dead ball situation, so none of the runners can advance. 

If a base runner is hit by a batted ball that was not touched by a fielder and 

no fielder had an opportunity to field the ball, the runner is out, but the 

batter is given a hit.  

If there are less than two outs, this can be entered by first marking the out 

by the runner (see Runner Out – Taking Extra Base) and then scoring the hit 

for the batter (see Hits). This will not work if there are two outs, however, 

since the inning will end with the third out and there is no way to enter the 

hit after that. 

If there are two outs and the bases are not loaded, you can reverse the 

order of the entry and give the batter his hit first followed by marking the 

runner out. This cannot be done if the bases are loaded, since the hit would 

score a run that should not be scored. 
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There is one method for scoring a runner hit by a batted ball that will work 

in all cases. Start by clicking on “FC” in the “At Bat Entry” area (see below) 

and select the runner who was out due to being hit by the ball (see below). 

Include the out detail. Next, double-click on the “FC” near the first base line. 

That will make it available for editing. Change it to “1B” (see below). Click 

on “Batter” to complete the entry. 

        

Interference 

Interference occurs when a runner interferes with a fielder’s opportunity to 

catch a batted ball or intentionally interferes with a fielder throwing or 

catching a thrown ball. Depending on the type of play, the umpires may call 

one or two outs. When the play is over, determine who was called out (ask 

the umpires for clarification, if needed) and then record the out(s) as if the 

fielders were able to make the plays that did not occur due to the 

interference (see Outs). 

Obstruction 

Obstruction occurs when a fielder who is not attempting to make a play 

interferes with a base runner. In some cases, the umpires will award extra 

bases to the batter or runner who was slowed by the obstruction or will 

overturn an out call. This should be scored the same as if the batter or 

runner reached the awarded bases without the obstruction being called. For 

example, if a batter gets to second base, but is awarded third base on 

obstruction, score it a triple (see Hits). 

End Of Half Inning 

There are three ways an inning can end – 
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 Three outs 

 Run rule limit 

 Home team scores the winning run in the bottom of the 7th or later 

inning 

In the first case, the scoring program will automatically end the half inning 

and switch the display to the other team. In the other two cases, you must 

manually end the half inning. After scoring the batter who brought in the last 

run in the inning, re-select that box in the scoresheet so that it is highlighted 

(see below). Then, click on the “Last” button in the “At Bat Entry” area 

followed by the “Batter” button (see below). 

      

Remember that the last hit in an inning may be limited by the run rule. If 

only one more run can score, the batter cannot be awarded a hit that forces 

in more than one run. 

In-Game Lineup Changes 

Pitching Change 

If a pitcher is removed from the pitching position but remains in the game, 

he must be selected again on the second line.  Do this as you generally 

would if initially selecting him for that spot – pull down the “#” menu and 
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select the player.  Ditto marks should appear instead of his name. Tab over 

to enter his new position. Tab again to enter the inning of the change.  A 

simple Copy and Paste to the second line will also work.  Remember, 

however, to enter position and inning (see below). 

 

Then, go to the player coming in to pitch and do the same. Re-select the 

player on the second line; ditto marks should appear. Tab to enter P for 

pitcher. Tab once more to record the inning the change took place.  Copy 

and paste will work.  P for pitcher and inning must be recorded (see below). 

 

 

Note that for pitching changes in the middle of an inning, only the whole 

inning can be selected. The inning selected will be the first inning that the 

pitching statistics will be credited to the new pitcher. If any runs have 

scored, start out giving the current inning to the prior pitcher. If more runs 

are given up by the new pitcher, you can change the inning back to the first 

inning that the new pitcher pitched. 

This can be repeated several times during the game.  If more lines are 

needed, pull down the “Options” menu at the top of the page and select 

“Preferences”.  Then select however many lines you want to add for “Lineup 

Rows” and select “OK”.  

If you check pitcher names at the bottom of the opposing team’s page, the 

names of all who have been designated as pitchers and the inning each 

entered will be displayed (see below). 
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12th Player Out 

If a player leaves the game for injury on a team that starts with 12 players, 

there is no injury sub. Should that player’s spot in the order come up to bat, 

hit the “Skip” button (see below). A note is placed in the scoresheet (see 

below) and the scoring will advance to the next batter. This must be done 

each time that player’s turn in the order comes up. 
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  Skip Button     Scoresheet – Skipped Batter 

Injury Sub 

If a player leaves the game for injury on a team that starts with less than 12 

players, the player will be replaced by an injury sub. The entry of an injury 

sub is similar to the entry of a sub at the beginning of the game, but is 

entered on the second line of the lineup entry for the player he is replacing 

(see Adding a Sub). The other difference is that the “I” column in the lineup 

needs to indicate when the sub entered the game (see below). If the injured 

player batted in the inning he was replace, the inning indicated should be 

the next one so that he will get credit for his time at bat. The injury sub will 

receive credit for at bats from the inning indicated onward. 

 

If a pitcher is replaced by another pitcher while the team is in the field, the 

“I” column should take into account the considerations for pitching changes 

(see Pitching Change) to the extent that it does not interfere with any at 

bats being credited to the correct pitcher. 
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In some cases, an injury sub may not be a pitcher and pitching will be taken 

over by another roster player. In this case, the injury sub’s position should 

be set to a non-pitching position and the new pitcher indicated (see below). 

 

Extra Innings – Runner on Second Base 

In each half inning after the seventh inning the player who batted last in the 

prior inning for the team coming to bat is placed on second base. If that 

player gets a runner, the first batter prior who doesn’t take a runner runs in 

his place.  

To place the runner on second base in the scoring program, click on “More” 

in the “At Bat Entry” (see below). Click on “ITB – Int’l Tie Breaker” and then 

click on the “Batter” button to complete the entry (see below). The first 

batter of the inning should now be highlighted for scoring. 

Note: Sometimes when the first ITB is entered, the “Batter” button does not 

correctly advance the batter. If not, simply select the first batter of the 

inning after entering the ITB. The “Batter” button should work fine after 

that. 
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Games Ended by Weather 

Games that end due to weather (rain or lightning) before the top of the 5th 

inning with the home team leading or before the bottom of the 5th inning 

with the visiting team leading are not official games. Do not finalize games 

that are not official. 

Games are complete if the top of the 7th inning has completed with the home 

team ahead or the bottom of the 7th inning has completed with the visiting 

team ahead. 

If a game is official, but not complete, only include scoring for completed 

half innings. Do not include scoring for the top of an inning that is completed 

if the home team is behind. You do not need to erase scoring that is not to 

be included. Instead, set the last inning scored correctly when finalizing the 

game (see FINALIZING THE GAME). 
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Corrections 

There are lots of reasons why it might be necessary to make a scoring 

correction during a game. Sometimes the mouse jitters just when you go to 

click on something and the wrong selection is made. Sometimes the umpires 

change a call after you have entered a play. Whatever the cause, be sure 

that you will have time to make the correction before needing to watch the 

next play. If you are not between innings, ask the announcer to hold the 

game (see Pause the Game). 

Undo 

The simplest corrections can be done with the “Undo” button (see below). 

This button will remove the last entry made. The spray chart line, at bat 

result, and runner advances are all considered as independent actions for 

undo, so it may take several presses of the undo button to clear an entire at 

bat. Be sure to watch what is undone each time the button is pressed to 

avoid going back too far or not far enough. If more than 1-2 at bats need to 

be undone, this may not be the best approach, but it is the only one that 

removes runner advances along with batting results. 

 

Cut / Paste / Clear 

Right clicking on a scoring box for a particular batter in a particular inning 

brings up an editing menu for that scoring box (see below). Selecting clear 

will clear the score box. Copy will copy the contents into the paste buffer. 
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Cut will copy the contents into the paste buffer and clear the cell. Paste will 

copy the contents of the paste buffer into the cell.  

These operations need to be done carefully, as they only effect the contents 

of that scoring box. Cut and Clear do not undo runner advances for previous 

batters due to the one being cleared. Paste does not advance runners and 

can cause multiple runners to end up at the same base. 

These operations are most useful for making major changes to multiple 

batters, like re-scoring a half inning. Generally, it is best to clear back to a 

spot where there are no runners on base and then re-score forward from 

that point to make sure runners advance in an orderly fashion. 

 

Corrections in Prior Inning 

In order to make any correction in a completed half inning, the third out or 

last batter in that inning must first be cleared (see above). After that, other 

changes may be made using the other operations. Undo cannot be used for 

this, even after the third out is cleared, since it undoes the clear. 

Stray Entries 

If, every time you hit the “Batter” button in the “At Bat Scoring” area, the 

highlighted box jumps to somewhere unexpected, it is likely that one of two 

things have happened that need to be fixed. 

If the highlighted box jumps to the end of the prior half inning, the prior half 

inning was probably not ended correctly. Either there were not three outs 

recorded, or the “Last” button was not pressed (or was pressed and not 

recognized). If the “Last” button was not recognized, just highlight the last 

batter again and click “Last” to complete the half inning. If there were not 

three outs recorded, figure out where the third out should be and enter it. 
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If the highlighted box continuously jumps to a higher inning than what has 

been scored, check the box above for a stray entry. Even a spray chart line 

entered in a scoring box in a later inning will cause the program to think that 

the next batter follows that point. Clear the stray entry and the behavior 

should stop (see Cut / Paste / Clear). 

Avoiding Scorekeeper Errors 

There are a few good practices that can keep you out of trouble so that 

corrections are minimized. These are not mandatory, and over time each 

scorekeeper will develop their own routine. These are presented to provide a 

guide to mostly newer scorekeepers. 

Watch the Whole Play 

In order to accurately score the play, you need to watch the whole play 

develop, from the bat striking the ball until the umpire calls for time out. If 

you look down at the screen during the play, even for a moment, you are 

likely to miss something that may be important. 

Double-Check After Each Play 

After each play, you should double check that the score sheet agrees with 

the score on the scoreboard, the number of outs on the scoreboard, players 

on base, and who is up to bat. Check the score at the end of each half 

inning, as well. Save the scoresheet every half inning. To do this, pull down 

the “File” menu and click on “Save” after you have verified the score (see 

below). This also limits the lost entries in case of a computer malfunction. 
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Question Unclear Calls 

If you don’t understand the result of a play – ask! Start with the announcer. 

If they don’t understand the play either, then have them question the 

umpire. Don’t let play proceed until you understand why the runners are 

where they are, the number of outs, etc. Do not question who is up with 

anyone on the field, though, only with your announcer (see Batting Out of 

Order). 

There was a classic case of this a few seasons ago during a playoff game 

where the scorekeeper found that after 5 batters there were two out, two on 

base and two runs scored. It took more than a few minutes to determine 

that one of the runners who was called out proceeded to the next base and 

stayed there. On a subsequent play, he “scored”. When faced with a 

situation that shouldn’t be possible – question it! 

Pause the Game 

Everyone falls behind sometimes. This can be caused by – 

 A complex play 
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 The umpires change a call 

 You click on something wrong and have to undo it 

 The computer glitches 

When something happens that you know will be difficult to do before the 

next batter comes up, ask the announcer to stop the game right away. Being 

proactive will save you a lot of grief and stress. 

If you fall behind, even one batter, ask the announcer to get the umpire to 

stop the game while you catch up. It is better to pause a game 30 seconds 

10 times than once for 5 minutes. Most players will not complain about short 

pauses, but will be annoyed with longer delays, particularly in weather that 

is marginal to play (hot or rainy). The smaller corrections are also more 

likely to be made correctly than larger ones. If you look up from entering a 

play and the batter you expect is not at the plate, get the game stopped 

(between pitches!). It always seems like when you get behind, the next 4-5 

batters will put the first pitch in play. 

Some scorekeepers bring a pad of paper and when they start to fall behind 

will record the plays on paper so that they can catch up between innings. 

This is OK, but not recommended. I’ve seen innings where the number of 

batters could not be entered in the time between innings, and it is not trivial 

to skip a half inning that hasn’t been entered to start entering the next half 

inning. 

Develop a Routine 

Get used to entering plays in a repetitive sequence. A sequence that works 

well is – 

 Enter the spray chart line 

 Add RBIs for runners that were not forced in (as needed) 

 Enter the batter’s results 

 Advance unforced runners (as needed) 

When there are options for entering something (e.g. hits, outs), use the 

same method all of the time so that you get used to it. 
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FINALIZING THE GAME 
Once the game is completed, the score sheet must be finalized in order to 

generate reports used by “The Daily Sun” and to update the Division 3 Web 

Site. Note that “The Daily Sun” picks up these reports directly from our 

Dropbox during the afternoon on game days. This is one reason it is 

important to let one of the scoring coordinators know right away if anything 

unusual happened during the scoring of a game (see Unusual Events). 

Game State 

To begin the process of finalizing a game, pull down the “Tools” menu, slide 

down to “Game State” and select “Finalize Game…” (see below). 

 

The first step of the Finalize Wizard does some validation checks (see 

below). Unfortunately, many of the checks it does do not apply to our use of 

the program. It will always complain if two defenders have the same 

position. Since the program only allows one center fielder and we have two, 

it will always note this. If you have made a lot of corrections (see 

Corrections) the program can get confused and complain about other 

“issues”. For the most part, this screen can be ignored. Simply click on 

“Next>” to view the next screen. 
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On the next screen, you will need to set the “Game State” to indicate the 

reason for the game ending (see below). Select “End – Extra Innings” or 

“End – Run Rule” if one of them applies. Otherwise, select “End – 

Regulation”. 
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Regulation Innings 

Check to make sure that the “Regulation Innings” is set to “7 – 

Fastpitch/Baseball” (see below). If not, please change it. This is often, but 

not always, set correctly to begin with. 
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Last Inning 

Check to make sure that the “Last Inning” (see above) is set correctly to the 

last official inning played (see Games Ended by Weather). This is often, but 

not always, set correctly by the program when the game ends. Please 

correct it if it does not reflect the correct half inning. It is important that this 

correctly reflect the innings scored or some statistics may be lost. Click on 

“Next” to proceed. 

Winning / Losing Pitchers 

Next, select the Winning and Losing pitchers (see below). Most teams only 

have one pitcher in the game, but if there was a pitching change the Losing 

pitcher is the pitcher on the losing team that gave up the lead closest to the 

end of the game (not necessarily the last run given up). The winning pitcher 

was the pitcher on the winning team who pitched the prior half inning. Do 

not award a “Save”. We don’t use that statistic. Click on “Next” once the 

pitcher have been selected. 
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Add Game to Seasons 

Next, make sure that the game is selected to be added to both teams’ 

season (see below). Click the appropriate checkbox(s) if they are not already 

checked. Then, click on “Finish” to complete the finalization. 
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Pull down the “File” menu and click on “Save” to save the finalized game 

(see below). 
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Game Reports 

Once the game is finalized, two game reports need to be generated.  

To generate the “Game Summery”, pull down the “File” menu (see above) 

and select “Export Game Summary …”. A file dialog will pop up (see below). 

Click on “Save” without changing the file name. The “Game Summary” will 

then be opened with the Chrome web browser (see below). Click on the “X” 

in the upper right corner of the window to close it. 

To generate the “Scoresheet”, pull down the “File” menu (see above) and 

select “Export Scoresheet (Brief) …”. A file dialog box will pop up (see 

below). Click on “Save” without changing the file name. The “Scoresheet” 

will then be opened in Adobe Reader (see below). Click on the “X” in the 

upper right corner of the window to close it. 

Once the reports have been generated, close the game by pulling down the 

“File” menu and clicking on “Exit” (see above). 
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Verify Dropbox Updates 

First, check that there are now three files in the dropbox for your game with 

the following file types – 

 Chrome HTML Document 
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 KFFILE 

 Adobe Acrobat Document 

Make sure that you see the Dropbox icon on the lower right of the screen 

that looks like . Hover the cursor over the icon and make sure it says 

“Up To Date”. If you don’t see this, the files have not been copied to 

Dropbox.  

If you don’t see the files and the “Up To Date” indication from Dropbox 

within a few minutes, please notify one of the scoring coordinators prior to 

leaving the field so that corrective action can be taken (see Unusual Events). 
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COMPUTER SHUTDOWN 
If you score the last game for the day on a field, you should shut down the 

computer and return it to the storage box after the game is complete. If you 

are the last to do so, please lock the storage box. 

Verify Dropbox Updates 

It is very important to verify Dropbox updates prior to shutting a computer 

down. If a computer is shut down without Dropbox being updated, it will 

need to be turned back on to get the files for “The Daily Sun” and the web 

site updates. 

Make sure that you see the Dropbox icon on the lower right of the screen 

that looks like . Hover the cursor over the icon and make sure it says 

“Up To Date”. If you don’t see this, the files have not been copied to 

Dropbox.  

If you don’t see the files and the “Up To Date” indication from Dropbox 

within a few minutes, please notify one of the scoring coordinators prior to 

shutting down the computer so that corrective action can be taken (see 

Unusual Events). 

Windows Shutdown 

To shut down the computer, click on the Windows icon on the lower left of 

the screen that looks like . The windows menu will pop up and the 

power icon will appear just above the Windows icon. Click on the Power icon 

and select “Shut down”. This may take a few moments, but eventually the 

power will shut off and the screen will go blank. Turn the power off on the 

mouse, and for the All-In-One computers, turn the power off on the 

keyboard (see below). Unplug the power cord from the computer and the 

power strip.  

Remove the glare shield from the computer by gently grasping the lower 

corners of the shield and gently pulling them out away from the computer. 

Then, rock the top backwards until it comes free of the computer. 
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Computer Storage 

Place the computer, keyboard and mouse in the slots provided for them on 

the left side of the storage box (see below). The laptop computer goes in the 

back slot, which is fitted with padding to hold its smaller size securely. 

Please be careful not to let the padding slip out of place when storing the 

laptop. Place the mouse pad and power cord in the bin on the right side of 

the storage box. 

Fold the two sides of the glare shield together with the top and place it in 

the cardboard box behind the computer storage box. 
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Storage Box Lockup 

Close the lid on the box. The lock should be attached to the hasp (see 

below). Remove the lock, close the hasp and put the lock through the loop 

so that the numbers on the lock will face outward when closed (see below). 

This will make it easier to open. 
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COMPUTER STARTUP 
Scoring computer setup should begin at least 1 hour prior to the first games. 

This allows time for the computers to run system checks that come due 

during the times that the computers are shut down so that they are 

completed prior to having to start scoring a game. These checks can slow 

the computer and make the scoring process more cumbersome. It also 

allows time to correct network and other system issues that are encountered 

during the setup process. Lastly, it allows the setup people time to get to 

their game and warm up a bit. 

Storage Box Access 

There are two locks on the storage box. One is only used to lock the box to 

the bench in the score booth. That lock should not be opened. The second 

lock is on the hasp that closes the lid of the box (see below). Enter the 

combination there and open the box. Hang the open lock on the hasp so that 

it can be easily located when it is time to close the box (see below). 

      

All-In-One Computer Setup 

Place a computer, keyboard, mouse pad and mouse on the right side of the 

desk for each field that will be using an All-In-One computer. These devices 

are color coded. Keep the same colored dots together. Power cords are only 

color coded for the Laptop Computers. Any power cord without a color dot 

may be used for the All-In-One computers. Plug the power cord into the 

bottom right outlet on the computer unit (see below) and then into the 

power strip in the tower. Power on the mouse and keyboard. The switches 

are on the underside of each (see below). Power on the computer. The 

button is on the upper right on the back of the computer (see below). 
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Power Cord     Mouse Power Switch 
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 Keyboard Power     Computer Power 

 

Laptop Computer Setup 

Place a computer, mouse pad and mouse on the right side of the desk for 

each field that will be using a Laptop Computer. These devices are color 

coded. Keep the same colored dots together. Power cords are also color 

coded for the Laptop Computers. Plug the power cord into the left side rear 

outlet on the computer unit (see below) and then into the power strip in the 

tower. Power on the mouse. The switch is on the underside of each (see 

below). Power on the computer. The button is on the left side above the 

keyboard (see below). 
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Laptop Power Cord and Power Button 
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 Mouse Power Switch 

Computer Use Rotation 

In seasons where fewer than four fields are used, it is important to rotate 

the use of the computers from game day to game day. That way, the virus 

updates (see Anti-Virus Verification and Update) will be performed on a 

regular basis for all computers. Also keep in mind the special weather 

considerations for setting up the computers (see Special Instructions – 

Windy Days and Special Instructions – Hot Days). 

Computer Login 

When a scenic image appears on the screen hit ‘enter’ on the keyboard or 

click anywhere with the mouse. Type the password when prompted 

(capitalization is significant). Allow a few minutes for the desktop to appear 

and be populated with icons. 

WIFI Startup and Login 

Connection to the WIFI should be automatic, but it often needs some help to 

complete.  

If the Wi-Fi icon at the lower right part of the screen looks like , then 

left-click the icon. You will see a list of networks. Connect to the network 

called “TheVillagesDotNet”. This action should open the browser (Chrome) to 
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a login page that is pre-populated with a Villages ID and PIN. If the ID and 

PIN are not there, you can use yours. Any valid one will work. Once you click 

on “Accept” the network will connect. 

If the Wi-Fi icon at the lower right part of the screen looks like , then 

the network is connected, but you need to log in. Open the Chrome browser 

and click on the shortcut for “The Villages Login” (or click on “The Villages 

Net Login” on the desksop ). This will take you to the login page that 

is pre-populated with a Villages ID and PIN. If the ID and PIN are not there, 

you can use yours. Any valid one will work. Once you click on “Accept” the 

network will connect. 

Dropbox Startup and Verification 

Once the network is connected, Dropbox will start the process of connecting 

and updating the local files from the network. Initially, the Dropbox icon on 

the lower right part of the screen will look like  to indicate that it has not 

yet connected to the network storage. If you hover the mouse over the icon, 

you may see a status of “Connecting…” or some other. No action is required. 
Dropbox will connect, but it may take a few minutes. This is why the first 

scorekeeper for a given field must come early to the field to allow for this 
time. 

Once Dropbox connects to the network, the icon will change to . This 
indicates that files are being updated on the local drive from changes that 

were made while the computer was not running. This also may take a few 
minutes. You can get a count of files remaining to synchronize and an 

estimate of the remaining time to complete this by hovering the mouse over 
the icon. 

Wait for the synchronization to complete. The icon will change to . If you 
hover the mouse over the icon, the status of “Up To Date” will be displayed. 

Any time you change a file in dropbox, the icon will change back to  for 
a few seconds. 
 

Anti-Virus Verification and Update 

Next, check if the Anti-Virus software is up to date on the computer. In the 

lower right of the screen near the time, click on the up arrow icon (see 
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below). This will display the state of the Anti-Virus software (see below). If 

the checkmark on the shield is green, no action is required. Otherwise, click 

on the icon and the Windows Security status screen will open. Click on the 

“Install Updates” button. When the update is complete, all of the sections 

will have green checkmarks in them (see below). 

              

Taskbar Up Arrow  Anti-Virus Status Icon 

 

Windows Security Status Screen 

Today’s Games 

Double click the “Today’s Games” Icon  on the desktop to open the 

folder with the game files. This will open the “Div-3-Games” folder in 
Dropbox. In this folder, you should find a file for each game being played on 

this date. The name of each game file should look like “XXXXX v YYYYY mm-
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dd-yyyy.KSS”. Where XXXXX and YYYYY are the first 5 letters of the visiting 

and home team and mm-dd-yyyy is the date the games are being played. 
There may be a few other folders and files shown, as well. 

 

Player List 

Double click the “Player List” Icon  on the desktop to open the Player 
List Tool. This tool will assist scorekeepers in adding subs to the lineup and 
verifying that lineups are valid before the game begins. The main window of 

the Player List Tool is shown below. 
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Lineup Changes 

Check for late changes to the game lineups by clicking on the “Download 

Game File” icon  on the desktop. This will take you to the Lineup 

Manager tool and display a list of games for the current play date, plus one 

game ahead for the team with a bye, if there is one (see below).  
 

 

If there is an “H” or “V” (or both) in the column labelled “Updated”, it means 

that the lineup for that game has been updated since it was downloaded into 

the “Today’s Games” folder. To get the update, click on the “ScoreFile-n” 

button that corresponds to the game(s) with the update. A “Save As” dialog 

box will open (see below). 

Select the “Div-3-Games” folder in Dropbox. Select the file you want to 

replace. You will be prompted to ask if you want to replace the existing file. 

Click “Yes”, after you verify that the file is for the game you are scoring. 
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